
      

 
 
 

 

PhD Thesis 

Research Regarding the Application of Neural Networks in the 

Organizational Management 
 
 

 

SUMMARY 

 

 

 

M.Sc. Ing. Simona-Ioana MARINESCU 
 

 

 

Scientific Leader 

 Prof. Univ. Dr. Ing. DHC Constantin OPREAN 

 

 

 

 

 

 

 

 

 

”Lucian Blaga” University of Sibiu 
 

2017 

 



“Cercetări privind Aplicarea Reţelelor Neurale în Managementul Organizaţional” Ing. Msc. MARINESCU Simona-Ioana 

 

2 
 

 

 

 

PhD Thesis 

Research Regarding the Application of Neural Networks in the 

Organizational Management 

  
 

 

SUMMARY 
 

 

 

 

M.Sc. Ing. Simona-Ioana MARINESCU  
 

 

 

 

Scientific Leader: Prof. Univ. Dr. Ing. DHC Constantin OPREAN  

 

 

 

Guidance Committee:    Prof. Univ. Dr. Ing. Dr. Ec. Mihail Ţîţu 

                                          Prof. Univ. Dr. Ing. Dănuţ Dumitraşcu 

                                          Prof. Univ. Dr. Ing. Claudiu Kifor 

 

 

 

 

 

 

”Lucian Blaga” University of Sibiu 
  

 

2017 



“Cercetări privind Aplicarea Reţelelor Neurale în Managementul Organizaţional” Ing. Msc. MARINESCU Simona-Ioana 

 

3 
 

CONTENTS 
 

 

 Thesis   Summary 

PREFACE  ………………………...7 4 

INTRODUCTION …………...…………..11  

Chapter 1. Aspects of the current state of use of 

"Neural Networks" in management 

 

….……………..….….14 5 

Chapter 2. System approach of neural networks ………….……..…..32 9 

Chapter 3. Research goals and objectives of the 

PhD thesis  

..………………… 57 11 

Chapter 4. Contributions regarding the 

involvement of informatic systems in the 

development of neural networks 

..…………………. 78 12 

Chapter 5. Contributions regarding the use of 

neural networks in human resource management 

and establishment of the organizational structure  

..………………….106 20 

Chapter 6. Contributions regarding the use of 

neural networks in establishing competitive 

strategies in organizations with activity in the 

"Nonconventional Technologies" field  

..………………….127 22 

Chapter 7. Contributions regarding the design of 

neural networks applicable to the strategic 

management of an organization  

…………………...149 27 

Chapter 8. Final conclusions, original 

contributions and future research directions  

………………….....162 32 

Bibliography …………………….170  36 

List of abbreviations 

List of figures 

List of tables 

ANNEXES 

Appendix 1. Matlab environment structure 

Apendix2A. The database for the training of the 

feed-forward-binary neural network 

Appendix 2B. The database for the trening of the 

feed-forward-numerical neural network  

…………………….187 

…………………….189 

……………..….…..193 

 

 

……………………195 

 

……………………208 

 

……………………277 

 

 

 

 

 

 

 

 

 

 

 

 



“Cercetări privind Aplicarea Reţelelor Neurale în Managementul Organizaţional” Ing. Msc. MARINESCU Simona-Ioana 

 

4 
 

Appendix 3.  Predictions of the MLP(5:5:1) model                                                               

towards the test values 

……………………346  

 

 

PREFACE  

Keywords 

Artificial intelligence; neural/neuronal networks; organizational management; computer 

systems; competitive strategies; strategic management; nonconventional technologies; 

NeuroSolutions MATLAB 

              The PhD thesis is structured in 8 chapters, chapters comprising 194 pages, 90 figures, 28 

tabels, 261 bibliographical references and 3 annexes (168 pages). 

              The first chapter, ”Aspects of the current state of use of "Neural Networks" in 

management” presents some research fields and applications in production of neural networks and 

the first contributions of the author herself regarding the definition of the „neural network” vs. 

„neuronal network” phrase.  

 The second chapter, ”System approach of neural networks” presents the definition 

elements of the neural networks, the structures and the classification of the neural networks. 

            Chapter three consists of  ”Research goals and objectives of the PhD thesis”.  

            It summarizes the conclusions of the analysis of the current state of the implementation of 

neural networks in the field of management as well as the main objectives and future directions of 

research.  

            The fourth chapter is titled "Contributions regarding the involvement of informatic 

systems in the development of neural networks" and presents the system concept with the related 

informatic subsystems and the definition and adaptation of some softwares and programs for the 

realization of some applications in the field of neural networks: NeuroSolutions and MATLAB. 

             Chapter five, ”Contributions regarding the use of neural networks in human resource 

management and establishment of the organizational structure” presents the approach to the 

reproduction of the biological neuron in the structure of an organization, and the contributions to 

the adoption of a certain organizational structure of some industrial organizations with specific 

activity in the field of Nonconventional Technologies. 

            Chapter six, “Contributions regarding the use of neural networks in establishing 

competitive strategies in organizations with activity in the "Nonconventional Technologies" 

field”, presents the necessary elements for the elaboration of these strategies.  
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Chapter seven, “Contributions regarding the design of neural networks applicable to 

the strategic management of an organization” highlights the results obtained in modeling with 

feed-forward and neuro-fuzzy neural networks.  

Chapter eight presents ”Final conclusions, original contributions and future research 

directions”.  

            Within the doctoral program of scientific research, 10 papers were made and published, out 

of which 7 as the first author, 5 of which were published in magazines indexed in international 

databases and 5 in volumes of conferences with sections in the thesis’s field (ISI, EBSCO, 

ProQuest, Google Scholar, etc.). 

CAPITOLUL 1 

ASPECTS OF THE CURRENT STATE OF USE OF "NEURAL NETWORKS" 

 IN MANAGEMENT  

When creating an artificial intelligence system, one of the difficult problems is the computer 

simulation of certain actions: to create sounds and to judge, to draw conclusions on the basis of 

mere perceptions of certain situations. 

After 1995, mostly in the last 4-5 years, major applications are being developed of neural 

networks in modeling, simulation and management of industrial processes. 

In 2013, scientists from the University of Illinois, Chicago (UIC) have tested one of the 

best artificial intelligence systems - ConceptNet 4 and the results showed that the system is as 

intelligent as a normal child with the age of four years, except the fact that the scores varied from 

one subject to another (figure 1.1).    

 

Figure 1.1. Robot as a child 

 Professor Robert Sloan, who led the study, said that: "If a child get scores that vary so 

much, then it would be something wrong with him," and that the system has done very well in  
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analysis test of the vocabulary and the analysis of the ability to recognize similarities. 

 Figures 1.2., 1.3., and 1.4 show a comparison between an artificial neural network and a 

biological neural network to highlight the similarities between the two.   

 
Figure 1.2. Comparison between biological neural network  and artificial neural network 

 

Figure 1.3. Interconnecting neurons 

 

                                     Figure 1.4. Artificial Neural Network 
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Figure 1.5 shows the differences between a computer and the human brain. 

 

Figure 1.5. Comparison between a computer and the human brain 

 The neural network is easier than the neuronal network, having lower computing units 

capacity. Therefore, by following advanced studies in this field, it is primarily intended to carry 

out a range of comparative research "targeted approach versus systemic approach," "neural network 

versus neuronal network", "artificial intelligence versus intelligence of the living world" 

"organizational neuron versus biological neuron."  

 In this context the three parts that make up the neuron (neuron structure, Figure 1.6): cell 

body, dendrites and axon will be compared with the structure of an organization in order to 

determine within it who has which role / position, how can the biological neuron can be reproduced 

and its reproduction at the structuring level of an organization. 

 
Figure 1.6. Components of a neuron 
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  Nerve cells called neurons are fundamental elements of the central nervous system (CNS).  

In this system there are about 5 billion neurons. 

Neurons have five specialized functions: 

 receive signals coming from the vicinity of the neuron; 

 integrates (sums up these signals); 

 give rise to nerve impulses; 

 lead these impulses; 

 transmit impulses to other neurons. 

The nucleus is the cell body and supervises biochemical transformations necessary for the 

synthesis of enzymes and other molecules necessary for the neuron’s life. The cell body has a few 

micrometers in diameter. 

Each neuron has a dendrite structure around it; they are thin tubes, cross, extended on 

several tens of micrometers. Dendrites are the main receiving recipients of the neuron, receiving 

signals from other neurons, signals they transmit to the neuronal soma (body neuron). 

 The axon represents the centrifugal ending of the neuron, which aims to transform signals 

to target cells represented by the neurons that he makes synapses with. In the axon the signals are 

converted into nerve impulse trains or nerve impulses or potential of neuronal action. The axon is 

longer than the dendrites ranging from one millimeter to more than a meter long; axonal endings 

are called the done button.  

The connections between neurons are achieved via synapses. Synapses are connections 

between the axonal endings of the transmitter neuron and soma or dendrites of the receiver neuron. 

Synapses can have through a chemical mediator an excitatory or inhibitory effect. 

There is no generally accepted definition for neural networks, the majority of authors agree 

that they represent some simple processing assemblies aimed at interacting with the environment 

and also holding biological brain abilities to learn, being strongly interconnected and operating in 

parallel. 

Personally, I think that the neural networks represent a simulation (clone) of the 

capacity of the human brain, weaker, however, than the neuronal networks, with the power 

to learn, but only as much as they will be allowed by the person that schedules them (creates 

them). 

Therefore, I will use the term "neural network" for all research and personal statements and 
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the expressions: "neural network" or "neuronal network" as seen in the works analyzed in the 

literature. 

     CHAPTER 2 

SYSTEM APPROACH OF NEURAL NETWORKS 

Neural Networks have connections with a lot a fields, including: Biology, 

Neurophysiology, Cognitive Psychology, Informatics (Artificial Inteligence,Data Mining), 

Engineering (Signal Processing, Adaptive Control), Mathematics (Liniar Algebra, Numerical 

Analisys, Statistics, Differential Equations), Economy (Stock Prediction, Risk Analysis). 

 As in any other field, the study of neural networks has also experienced periods of intense 

research, and periods when the estate was neglected. 

 Studies began its state in the late nineteenth century, early twentieth century, and those 

who issued the first theories in this area are Hermann von Helmholtz, Ernst Mach and Ivan Pavlov. 

 The first practical application, the perceptron, appeared in 1959 - carried out by Frank 

Rosenblatt-used for character recognition. 

Amongst the areas where the use of neural networks had good results, are: 

- Approximations of functions; 

- Control of industrial robots; 

- Classification; 

- Recognition of patterns and voices; 

- Financial projections; 

- Market Research; 

- Forecast of marketing; 

- Medicine etc. 

 In recent decades, advances in neuroscience have been spectacular, particularly those 

related to the properties of neurons and complex molecules that affect neuronal response1[49].  

 Thus, the discovery of brain nature and principles which govern the activity, we may be 

able to understand the functions of perception, learning and other mental functions. 

 Knowledge of the human brain functions, central nervous system, allowing us to 

understand how the artificial neuronal networks (neural networks) work and are developed.  

In 2013, scientists from the University of Illinois, Chicago (UIC) have tested one of the 

                                                           
1 Dzitac, I., “Inteligenţa artificială”, Editura Universităţii Aurel Vlaicu Arad, 2008.  
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best artificial intelligence systems - ConceptNet 4 and the results showed that the system is as 

intelligent as a normal child with the age of four years, except the fact that the scores varied from 

one subject to another. 

 The Turing Test consists in a simple conversation between a human being and a machine 

(computer) softwared specifically for the test. Those who participated at the conversation were not 

able to see or hear each other. If the jury, after the conversation, could not distinguish the man and 

the computer, then the computer (the artificial intelligence) won. Turing started from a very simple 

idea: if we can not define intelligence, but still say about a person that is smart, then why can’t we 

say the same thing about a machine (robot) that would act like a human. 

 Structure and classification of neural networks 

 Even if their functioning resembles the neuronal networks, the neural networks have a 

different structure, much simpler, composed of units with lower computing capacity than the neural 

networks. 

 Some of the criteria underlying the classification of neural networks are2 [46]:  

- The number of layers of artificial neurons; 

- The type of the used artificial neurons; 

- The interaction and influence between neurons; 

- The network topology; 

- The type of learning; 

- The symmetry of the connections, the number of layers; 

- The evolution time of the network status, etc.   

 Typical disadvantages of the neural and neuronal networks: 

- A drawback of neural networks is the lack of theory that specifies the number of elementary 

neurons, the type of the network and the interconnection method. 

- A drawback of neuronal networks is the fact that, in some cases, they require a lot of steps, even 

thousands of steps which require a long time to be resolved. This disadvantage is also for the neural 

networks, due to the fact that the processor of a standard computer can calculate only separately 

each network connection. This is troublesome for large networks with a large amount of data. 

 Properties and Characteristics of Neural Networks 

Simon Haykin believes that a neural network is a massive parallel processor, distributed,  

                                                           
2 Dumitrescu, D., Hariton, C.,  “Reţele neuronale. Teorie şi aplicaţii.” Editura Teora, Bucureşti, 1996.  
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which has a natural tendency to store experimental knowledge and make them available for use3 

[140].   

 The main properties of neural networks are: information and knowledge are distributed 

throughout the network (through synaptic weight values); neural networks provide a global 

response; possess learning (training) properties, adaptation, generalization, parallelism, robustness, 

fault tolerance and disturbance. 

The neural network’s characteristics are: 

 The Ability to Generalize: If they have been properly trained, neural networks are 

able to give correct answers even for different inputs from those who have trained them, as 

long as these inputs are not very different; 

 The Ability to Summarize: Neural networks can decide or draw conclusions of their 

own, even when they are confronted with noisy information or inaccurate or partial 

information; 

 The Ability to Learn (the main feature): Neural networks do not require strong 

programs, but are rather the result of training on a massive set of data. Neural networks 

have a learning algorithm, whereupon the weights of the connections are adjusted on the 

basis of presented models; neural networks learn from examples. 

 Some of the criteria underlying the classification of neural networks are 4 :  

-  the number of artificial neurons layers; 

-  the type of used artificial neurons; 

- the reaction and the influence between neurons; 

-  the network topology; 

-  the learning mode; 

-  the connection symmetry, the number of layers; 

-  the evolution of the network state over time etc. 

                                            CHAPTER 3 

OBJECTIVES AND RESEARCH DIRECTIONS OF THE PHD THESIS 

 Managerial activity involves a continuous, coherent and successive decision-making 

                                                           
3 Neagu, C., Ioniţă, C.,  “Reţele neuronale. Teorie şi Aplicaţii în modelarea şi simularea proceselor şi sistemelor de 

producţie”, Editura Academiei, 2004  
4 Dumitrescu, D., Hariton, C. – Reţele neuronale. Teorie şi aplicaţii. Editura Teora, Bucureşti, 1996  
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process. In this context, the decision is found in all management functions and, as a result, in 

the forecasting component, neural networks being a real help in this direction. 

Given the complexity of the organizational management issues, the development of 

future research will be directed specifically towards the use of neural networks in the field of 

Strategic Management and Human Resource Management.  

In this respect, in order to achieve the "foresight" act, we will pursue the definition of 

the specific stimules and neurons - in order to make the most relevant decisions applicable to 

the industrial organization in the decision-making process.  

At the same time, research will be developed on modeling and simulation of neural 

networks built for various structures of the industrial organization, ranging from SMEs to 

large organizations with complex organizational structures. 

CHAPTER 4 

CONTRIBUTIONS REGARDING THE INVOLVEMENT OF INFORMATIC 

SYSTEMS IN THE DEVELOPMENT OF NEURAL NETWORKS 

 Neural Networks (NN) can be a working tool (prediction) useful to all three constitutive 

subsystems (decisional, informational and operational) of the organizational system, representing, 

also, an operational working means of the organizational management, applicable to the IT system 

of the respective organization.  

 Defining and adapting software and programs for applications in the field of 

neural networks  

Solving the neuro-fuzzy problem was done using Matlab.   

MATLAB, using specialized toolboxes, Fuzzy Logic Toolbox- FLT creates the possibility of 

implementing techniques based on fuzzy logic, using FUZZY and FUZZYDEMOS. The FUZZY 

subdirectory contains function type files,  grouped into categories of functions and operations5:  

 functions for graphical user interface (GUI); editing functions for fuzzy inference system 

(FIS), membership functions, the rules used, the diagrams and the associated control 

surfaces; functions for generating FIS (by); functions for the implementation of other 

routines (FIS Sugeno type, type C-means clusters, etc.);  

 operations that relate to the difference between two membership functions with different  

forms (sigmoid, Gaussian, trapezoidal, triangular, etc.), to the concatenation of matrices, to 

                                                           
5 Curteanu, S., “Inițiere în Matlab”, Editura Polirom, Iași, 2008  
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the mesh of the FIS's, to the evaluation of the multiple membership functions etc. 

 
 Figure 4.1. Command window 

Fuzzy toolbox is accessed by typing "fuzzy" in the command window (Figure 4.1.). 

The system displays the FIS type editor, which processes the corresponding information of 

the systems based on fuzzy inference. At the top, the diagram of the system to be created is 

displayed; the entry and the exit are marked (Figure 4.2.).  

 

Figure 4.2. „FIS” Editor 

 It should be mentioned that the user can define multiple input and output variables. 
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 Entering input and output variables is realized in the following way: in the Edit menu select 

Add Variable - Input (for adding input variables) or Output (for adding output variables) (Figure 

4.3.).  

 

Figure 4.3. Selecting inputs/outputs 

 To delete these variables you select the variable you want to delete and from the Edit meniu 

and you select Remove Selected Variable. 

 After entering the variables, their names are established: the variable’s box is being 

selected and its name is being entered in the Name box. 

 After defining the name of the input and output variables, you define the membership 

functions and the universe of discourse for each variable. After that, you select the variable to be 

configured (from the Edit menu select Membership Functions) - Figure 4.4.  

The editor of the membership functions (Membership Function Editor) (Figure 4.5.) is used 

to create, cancel or modify the membership functions of the fuzzy system. 

Synthetic, defining the membership function involves the following steps: 

• from the Edit menu of the Membership Function Editor graphic interface you select Add 

MFS; 

• in the Membership Functions dialog box you select the number of membership functions 

that the variable can have; 

• in the Membership Functions box you determine the overall shape of the membership  
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functions (triangular - triumph, trapezoidal – trapmf, bell - gbellmf, Gaussian - gaussmf 

etc.); 

      

Figure 4.4. Selecting membership functions 

 

Figure 4.5. „Membership Function” Editor 

• the universe of discourse is defined in the Range box;  

• in the Display Range box, the user can choose to display the entire universe of discourse  
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 (in which case the same numbers as in Range box are entered), or to display a single 

sequence within the universe of discourse (in which case the numbers within the range 

displayed in the Range box are entered); 

• parameters that define the geometry of the membership function are set in the Params box- 

figure 4.6. 

 

Figure 4.6. Number of membership functions 

• for defining the functions, you select them one at a time and assign them proper 

names. 

 To redefine the shape of each function, you select one function at a time, after which its 

geometric profile is selected from the "Type" down list belonging to the Membership Function 

Editor (Figure 4.7.); to clear a function, you select it and from the Edit menu you choose Remove 

Selected MF.  

After defining the input and / or output variables, follows editing the rules for the Fuzzy system: 

 you open one of the FIS Editor or Memberships Function Editor or Editor windows; 

 from the Edit menu you select "Rules"; the program will display the Rule Editor  

edit window (Figure 4.8.). As the rules are written, they will be displayed. 

To define the rules, you follow the next steps: 

 you select the appropriate function to be edited from the entry list; 

 you click on the Add rule button and the rule will be automatically edited in the 

upper window of the rules editor (Figure 4.9.). 
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Figure 4.7. Changing the shape of a membership function 

 

 

                                        Figure 4.8. "Rule" Editor 

 

 To delete / modify one rule, you select it and then, subsequent, one of the "Delete rule" 

(for deletion) or "Change rule" (for change) buttons will be operated. 

To view the rules or surfaces, you select from the View menu one of buttons "Rules" or 

"Surface" (Figure 4.10.).  
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Figure 4.9. Define rules  

 

Figure 4.10. Selecting viewing rules or surfaces 

 modeling with neural networks, neuro-fuzzy type  

To model the relationship between indicators and strategy, a draft version of the model was 

to develop a neuro-fuzzy model6. Defining the membership functions and the corresponding values 

                                                           
6 Marinescu S.I.- Research on Applications of Neural Networks in Organizational Management. In ACTA Universitatis Cibiniensis, 

Vol. 65, Issue 1, pg.64-68. 2014, ISBN (online) 1583-7149, DOI: 10.1515/ancts-2015-0011, 2015, de Gruyter.  
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are the most important steps in defining the model. After training, the structure of the rules of the 

model is obtained. When the user changes the input values, the system automatically generates the 

output value. 

 A surface graph showing the relationship between inputs (indicators) and exit (strategy) is 

shown in Figure 1 which illustrates the locations of the fuzzy inferences, obtained for each variable 

fuzzy output (strategies) expressed by the first 2 entries (risk factor and compensation potential  

regarding the financial representative). The fuzzy inference spaces visually express the dependence 

of the fuzzy output variables, towards the fuzzy input variables on all the support area of the 

membership functions7. 

 Creating the neural network 

    

 

Figure 4.11. Steps to generate a neural network a) select the NN type; b) select number of 

hidden layers; c) Selection of options for the hidden layer; d) Select elements for the output 

layer 

                                                           
7 Marinescu, S.I., Titu, M.- Aspects Regarding the Possibility to Use “Neural Networks” in the Selection of the “R&D” 

Strategy in the “Nonconventional Technologies” Field. In ACTA Universitatis Cibiniensis, Vol67, Issue 1, Pg 179-

184, 2015, ISSN(online) 1583-7149, DOI: 10.1515/ancts-2015-0086, 2015, de Gruyter. 
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The next step is to generate a neural model. 

This can also be achieved using the system NeuroSolutions with the option NeuroSolutions  

Create/Open Network  New Custom Network. In this way, a new window is generated that will 

allow the selection of several types of neural networks (figure 4.11.).  

The generated network will be indicated in NeuroSolutions as a group of interconnected neurons 

as shown in Figure 4.12.  

 

Figure 4.12. Neural network generated in NeuroSolutions  

CHAPTER 5 

CONTRIBUTIONS REGARDING THE USE OF NEURAL NETWORKS IN 

HUMAN RESOURCE MANAGEMENT AND ESTABLISHMENT OF THE 

ORGANIZATIONAL STRUCTURE 

Neural networks can intervene by delivering useful-foresight-organizational 

management information to make relevant decisions, especially with regard to recruitment. 

 A case on how to use a neural network (NN) will be presented, based on certain 

characteristics of a company8. 

 It aims at presenting how a biological neuron will be transposed into an artificial neuron 

(people or departments within the company) and its reproduction at a structure level of the 

organization (functions of the nucleus,  axon, dendrites, and so on). 

 To illustrate such a neural network, a Research-Development company was chosen as a 

model (Figure 5.1.).  

                                                           
8 Marinescu S.I.- Research on Applications of Neural Networks in Organizational Management. In ACTA Universitatis 

Cibiniensis, Vol. 65, Issue 1, pg.64-68. 2014, ISBN (online) 1583-7149, DOI: 10.1515/ancts-2015-0011, 2015, de 

Gruyter  
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Figure 5.1. Flowchart of an R&D company 

In this case, the components of the organizational neuron are the following: 

Nucleus: The people in the department; 

Dendrites: The information that the department has to receive; 

Axon: The information coming out of the department to the higher level: 

Synapses: Top decision-making body from the department. 

We consider the Board of Directors is the nucleus, while the General Director ( the CEO) is the 

cell body. 

The Dendrites are: Scientific Board; Relationship with State Institutions, Agencies and Other 

Bodies Board; the Critical Infrastructure Protection Compartment; Quality Management 

Department; Financial Control and Internal Audit Service; Legal Services; Executive Director and 

Economical Director.  

The Axons are: Management Programs Department; Strategy and Cooperation Department; 

Informatical System, Infrastructure and Classified Information Department; Research Center and 

Intern Management Department. 

The Synapses are considered to be: National Programs Department; International Programs 

Department; Strategic Development, Intellectual Property and Business Development Department; 

Cooperation with European Departments; International Relationships Department; Promotion and 
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Information Center; Information System and Infrastructure Department; The Security Structure 

Department; Computer Certification Authority Department; Special Technology Department; 

Special Applications Department; Economic, Financial and Administrative Services and Human 

Resources, Safety and PSI Services.   

Neural Network Analysis can be applied, similarly, to large industrial organizations, 

with the prediction possibly leading to the disappearance/emergence of new departments 

with direct financial implications. 

CHAPTER 6 

CONTRIBUTIONS REGARDING THE USE OF NEURAL NETWORKS IN 

ESTABLISHING COMPETITIVE STRATEGIES IN ORGANIZATIONS WITH 

ACTIVITY IN THE "NONCONVENTIONAL TECHNOLOGIES" FIELD  

 The main starting point of the management impact moments is the important area of the 

scientific research, where the management action directions are explained by the considered types 

of strategies:  

a. the offensive strategies, characterized by high risk, high compensation potential in 

terms of financial results obtained as a result of assuming a risk, high potential in 

technological innovation, competence to analyze the market and of realizing 

commercial products; 

 Although, theoretically, these successful offensive strategies are adopted, especially for 

large industrial organizations, they can also be used successfully for small and medium 

organizations. 

 The large organizations, with high economic potential, can strongly support a R&D 

department in the "NT", but are often strongly motivated by those products and technologies that 

can make a substantial contribution to its profits and look less favorably at the new products that 

require a longer time to reach a substantial volume of sales. 

 The small organizations can easily adopt some offensive strategies of the R&D in the "NT" 

field, because of the fact that the same profit, which for a large organization is only part of the total, 

at the small organization it brings a contribution relatively much more important in the overall level 

of profitability. These organizations often provide more favorable conditions materialized in 

management style and leaner organizational structure, opportunities to focus its own resources, at 

some point, through a single project. 

b. the defensive strategies, characterized by low-risk and low compensation potential, are 
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suitable for those industrial organizations able to make a profit in conditions of strong 

competition, through the ability of controlling some of the market. This type of strategy is 

recommended to those industrial organizations with better results in the production and 

marketing than in the R&D field. 

c. the acquiring strategies (purchase of licenses) at which  two aspects can be considered:   

- purchase of licenses which presents, at one time, the opportunity to earn commercial 

gainings, by buying the results obtained from the R&D investment of other companies. This 

is because it usually obtains a small gain through the rediscovery through R&D in "NT" 

field of what was obtained from another cheaper source. 

- patenting some of its major innovations: represents  a support strategy for small 

companies and a convenient strategy for large companies; 

d.   the interstitial strategies, which have as main condition for applying the knowledge 

of the strengths and weaknesses of competitors; As a result, this type of strategy stems from 

the deliberate attempt to avoid direct confrontation, by analyzing and exploiting the weak 

elements in the R&D field of the potential competitors on the market and exploiting them 

when they match their strength items.  

       e.  the "incorrect" strategies: the application of new technologies in the industrial 

organization has great experience in developing new products whose market is owned by other 

companies. These strategies can not give favorable results, constant over time, unless they are also 

supported by an offensive strategy that maintains their won position. 

The main factors to be taken into account in formulating the R&D strategy in the "NT" are: 

 A. The technological prognosis on the environment in connection with the managerial 

strategy of the industrial organization treated in the strategic planning; it aims the following 

requirements in "N.T." field: 

- the phenomenological analysis and the new economic processes; 

- formulation of realistic development options; 

- ensuring a dynamic balance between the goals of permanent evolution and the level 

of resources. 

 The strategy which refers to R&D in the "NT" field, which can be seen as an extension of 

the strategic planning process, is using the technological forecast in a similar way, in the following 

areas:  
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1) identifying future competitive threats and maintainance chances and the expansion into new 

markets;  

2) avoiding the competition’s surprises;    

3) the major reorientation of the industrial organization’s politics in the following                 

directions:       

- identifying new technologies; 

- changing the industrial development  

-  strategy in the R&D field;  

4) the improval of the operational decision-making in the directions: 

- R&D portfolio; 

- selection of projects for R&D; 

- allocation of resources;  

- personnel policy.  

 In conclusion, we can say that all industrial organizations which have as object of activity 

and the introduction, the use or research in the "NT" field, will have to adopt some form of 

technological forecast, market-oriented, and the amount of effort for implementing these 

techniques must take into account the following: 

- the rate at which changes occur in the economic environment; 

-  the planning horizon; 

- the managerial strategy of the organization; 

- the creation and production potential of the organization; 

- the proven and potential resources that are available.  

 B.  The risk-compensation relationship  

  R&D should consider the risks arising both in addressing the entire set of “NT” projects 

and individual projects. Inherent risk occurs in the global approach of the “NT” problematic and is 

divided into the projects’ crowd at a certain level.  Therefore, in a company focused for example 

on “NT” research, both the offensive and defensive strategies can be applied, depending on each 

project.  

 After “analyzing the risk”, it results that the large industrial organization, able to relate risk 

to a large number of R&D projects, can favour an offensive strategy, while a small company, 
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because of the fact that it performs a limited number of projects, should focus, at first glance, 

towards a defensive strategy.  

 However, taking into account, in the smaller companies, the informal managerial style, the  

simple organizational structure (which avoids the hierarchical dilution of the willingness to accept 

the risk), the possibilities to concentrate the efforts at a particular time towards a  product- project, 

the risk awareness, it can be said that the small companies, either research or production in the 

"NT" field, may adopt an offensive strategy.   

 Subsequently, the management decision (Figure 6.1.) can have two contradictory 

reactions: 

- the decision to transfer the R&D effort fast, in the "NT" field and reducing the 

attempts to bring the classical technology closer to the  upper limit of the performance; 

- the decision to invest the bulk of capital in the existing technology. 

 

 

Figure 6.1.  Establishing the management decision 

 According to Figure 6.2, the evolution of the life cycle of a particular nonconventional 

technology results as a synthesis of the life cycles of the components. They evolve by the same 

law, but there is a certain hierarchy, according to their share when developing this technology. 
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Figure 6.2. The evolution of the lifecycle of a nonconventional technology 

 For small companies (Figure 6.2.) specialized either in production or in R&D in this area, 

with a limited material base, it is considered that the design and the construction of the related tools 

and the used operating modes, have the decisive influence over the technologie’s rentability, while 

for the large, specialized, companies, the ranking may be different. 

In these circumstances, the companies must predict the evolutionary way of the commercial 

launch’s lifecycle of a technology, for establishing the moment of action in order to enhance, so 

that it withstands the competitive market.  

 This prediction consists in determining the nodal point in achieving the maximum 

corresponding to components for determining the timing of action on each one (Figure 6.3.). 

 

Figure 6.3.  Determination of nodal point 

 Considering that the four action courses over the "nonconventional" product’s life cycle 

are being reduced to two main directions: I-conceptual direction (embedding specialized facilities 
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and equipment); II- user direction (embedding processing tools and schemes), the analysis of the 

life cycle curve highlights both the preponderance of the first and creating the premises of any local 

or general monopoly. 

 Determining the moment of the nodal point can be achieved depending on the specifics of 

each company, correlated with its involvement in the two strands, given the inherent difference 

between the two absolute maximums.   

 The correct analysis of the life cycle of the unconventional technology allows the establish 

of the optimal strategy for the company, both for for extending the profit period, and in the 

conditions of the analysis of some similar competitive products of the directions of action, in order 

to maintain and extend the marketplace with its own products. 

CHAPTER 7 

CONTRIBUTIONS REGARDING THE DESIGN OF NEURAL NETWORKS 

APPLICABLE TO THE STRATEGIC MANAGEMENT OF AN ORGANIZATION 

 "NN" may be particularly useful in forecasting the future strategy of joining the network 

(indications) and the corresponding outputs (proposed strategy) being highlighted in the table 

(matrix) 7.1. and Figure 7.1.  

Table 7.1. Analysis indicators for the selection of the strategical variant using the “NN” 

                           Strategy 

 

 

Indicator 

 

Offensive 

 

-A- 

 

Defensive 

 

-B- 

 

Absorbance 

 

-C- 

 

Interstitial 

 

- D - 

 

Incorrect 

 

-E- 

a. risk high low low medium low 

b. compensation potential 

regarding financial result 

high low high low medium 

c. potential in technological 

innovation 

high medium high medium medium 

d. the competence to 

analyze the market 

high high high high high 

e. the competence to 

concrete commercialize 

the products 

high high high medium medium 

Note: Each indicator will receive a score between 0 and 1, the allocated share being established 

by the analyst 
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Figure 7.1. The neural network for establishing the strategy 

 An example of allocating the numerical values of the indicators (X1 ... Xn) for different 

variants for choosing the future development strategy  (Y1 ... Yn) is presented in Table 7.2.  

  Table 7.2. Values assigned to the analysis indications with "NN"  

 

 The value of min ∑Xi  represents the capacity to analyse the topmanagement in a first 

phase, the capability of the institution to approach different strategies. The range Xi Є [0,5…1] 

and, implicitly, the max ∑Xi=1 value give the opportunity to apply the principles of any of the 

strategies taken in the analysis. 

The basic idea based on neural network modeling consists in applying an accessible 
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methodology that will lead to very simple networks, but that will provide very precise predictions. 

For this purpose, the attempts of modeling took into account the following aspects: 

- various softwares were used: Matlab and NeuroSolutions, comparing the results 

both in terms of their accuracy, and procedure;  

- different types of neural networks were tested, mainly from the category of feed-

forward neural networks (multilayer perceptron, generalized feedforward, 

modulation) and neuro-fuzzy; 

- five input variables were taken into consideration: risk factor, x1, compensation 

potential in terms of financial results, x2, potential for technological innovation, x3, 

competence in market analysis, x4, competence to sell the products, x5. The proper 

ranges of these variables were: x1  [0.1...0.4], x2  [0.1...0.4], x3  [0.1...0.3], 

x4(0...0.2], x1  (0...0.2],  these statements corresponding to "low", "medium" and 

"high";  

- the output variable was the strategy type that has been defined by combining the 

values that the input parameters take, respectively: offensive strategy, defensive 

strategy, absorbing strategy, interstitial strategy and incorrect strategy; the outputs 

of the five variables were associated with the numerical values 1, 2, 3, 4 and 5;  

- also, other issues have been formulated, with fewer inputs, respectively the 

following three cases, with three input variables each. Case 1 has inputs x1, x3 and 

x4, case 2 - x2, x4 and x5 and case 3 - x3, x4, x5. 

 Using the neuro-fuzzy model several runs were made, the aim being to determine the 

strategy is case in which different values of the input parameters are being considered. Table 7.3. 

shows the obtained results. From the statistical point of view, for the 18 considered cases, different 

strategies have been obtained: offensive (1), defensive (4) interstitial (8) and incorrect (5). 

     Table 7.3. Results of neuro-fuzzy model 

Case Parameters Resulted strategy 

x1 x2 x3 x4 x5 

1 0,15 0,15 0,15 0,15 0,15 Defensive 

2 0,35 0,15 0,15 0,05 0,05 Incorrect 

3 0,15 0,15 0,25 0,15 0,05 Defensive 

4 0,32 0,10 0,12 0,15 0,05 Interstitial 

5 0,3 0,2 0,25 0,01 0,1 Incorrect 

6 0,4 0,1 0,12 0,1 0,1 Interstitial  
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7 0,38 0,15 0,1 0,2 0,05 Incorrect 

8 0,4 0,3 0,3 0,2 0,2 Offensive 

9 0,3 0,1 0,01 0,01 0,01 Interstitial 

10 0,15 0,15 0,15 0,2 0,1 Defensive 

11 0,25 0,25 0,15 0,2 0,2 Defensive   

12 0,3 0,12 0,1 0,1 0,1 Interstitial  

13 0,35 0,2 0,05 0,15 0,05 Incorrect 

14 0,3 0,1 0,25 0,15 0,1 Interstitial  

15 0,3 0,1 0,1 0,15 0,2 Interstitial   

16 0,32 0,25 0,15 0,05 0,05 Incorrect  

17 0,36 0,28 0,08 0,12 0,06 Interstitial  

18 0,35 0,15 0,15 0,1 0,1 Interstitial   

 

 Given the fact that two modeling techniques have been applied, obtaining neural models 

with feed-forward type networks and neuro-fuzzy models, a comparison between them was 

necessary, both in terms of accuracy of results and applied methodology. Table 7.4. shows some 

example of predictions, pointing out that both models give the same results.   

 In the modeling with feed-forward  neural networks, a work algorithm was established, 

which takes into account, gradually, the possibilities to improve the models’ performance. Such 

attempts were: • testing different types of neural networks; • designing various topologies (number 

of hidden layers and number of neurons); • considering different sets of input data as number of 

entries (5 or 3); • different coding of outputs, depending on the chosen variant of modeling 

(regression or classification); • using different databases, expanded or collapsed (number of 

values); • dividing in different percentages in training and testing data; • using a different number 

of driving epochs.  

 Under these circumstances, the performances for training and testing for different models 

were recorded, of which the following have been selected for illustration: MLP (5: 40: 20: 1), MLP 

(5: 30: 15: 1), MLP (5: 12: 4: 1), MLP (5: 5: 1). 

Table 7.4. Comparison of the predictions made by the neural network MLP (5: 5: 1) and 

the neuro-fuzzy model  

 

Experiment 

no. 

Parameters Experimental 

strategy 

NN 

Strategy 

Neuro-

fuzzy 

strategy x1 x2 x3 x4 x5 

1 0.15 0.15 0.15 0.15 0.15 2 2 2 

2 0.35 0.15 0.15 0.05 0.05 5 5 5 
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3 0.15 0.15 0.25 0.15 0.05 2 2 2 

4 0.32 0.1 0.12 0.15 0.05 4 4 4 

5 0.3 0.2 0.25 0.01 0.1 5 5 5 

6 0.4 0.1 0.12 0.1 0.1 4 4 4 

7 0.38 0.15 0.1 0.2 0.05 5 5 5 

8 0.4 0.3 0.3 0.2 0.2 1 1 1 

9 0.3 0.1 0.01 0.01 0.01 4 4 4 

10 0.15 0.15 0.15 0.2 0.1 2 2 2 

11 0.25 0.25 0.15 0.2 0.2 2 2 2 

12 0.3 0.12 0.1 0.1 0.1 4 4 4 

13 0.35 0.2 0.05 0.15 0.05 5 5 5 

14 0.3 0.1 0.25 0.15 0.1 4 4 4 

15 0.3 0.1 0.1 0.15 0.2 4 4 4 

16 0.32 0.25 0.15 0.05 0.05 5 5 5 

17 0.36 0.28 0.08 0.12 0.06 4 4 4 

18 0.35 0.15 0.15 0.1 0.1 4 4 4 

 

 The best model was MLP (5: 5: 1), trained at 10,000 epochs, which provided 100% correct 

answers to the test. The results were also verified through formulating a classification  problem.  

 Also, in this case, the MLP model (5: 5: 5), with binary coded outputs had the best results, 

100% correct answers. 

 In the considering cases of three input variables (in different variations) instead of five, the 

results are not too good, the percentage of correct answers was 59%, 73% and 94%.  

 Weaker results have been obtained, especially the smaller percentages from the previous 

listing can be attributed to the removal of significant variables for some strategies,  that, as a result, 

have been wrongly classified.  

 Once again, this modeling is an argument for the complete case with five entries, 

respectively, for the fact that the 5 initial entries determine the considered strategies (100% correct 

answers). 

 Neuro-fuzzy models were designed using the Matlab system. Under this strategy, the most 

important steps are represented by the definition of the membership functions and the 

corresponding values. Subsequently, after the completion of the training phase, the model’s 

structure of the rules is being obtained, and then the model can be used to make predictions for 

different input data sets.  
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 A comparison between the neuro-fuzzy model and the MLP neural model (5:5:1) 

highlights the fact that the two types of patterns generate identical results. In these circumstances, 

the tools that have generated them are left for comparison, respectively Matlab and NeuroSolutions. 

Both are equipped with specialized software graphical user interface, choosing between the two 

methods is up to the user, depending on the preference and his ability.  

CHAPTER 8 

FINAL CONCLUSIONS, ORIGINAL CONTRIBUTIONS AND FUTURE RESEARCH 

DIRECTIONS 

Applications of neural networks in the management, compared with traditional statistical 

techniques are based on a number of advantages, such as: 

 N. N. can provide more accurate results than regression models; 

 N. N. are capable of learning complex relationships and to approximate any 

continuous function, maneuvering nonlinearities directly or implicitly; 

 significance and accuracy of models based on N. N.  can be determined using 

traditional statistical measures (e.g., mean square error and the coefficient of 

determination); 

 neural networks automatically handle any interactions between variables; 

 neural networks, as a preliminary nonparametric methods do not involve 

assumptions on the distribution of data input-output; 

 neural networks are very flexible in relation to missing or incomplete datas; 

 neural networks can be applied dynamically; 

 neural networks exceed a number of limitations of other statistical methods; 

 neural networks have associative skills - once developed, a neural network is robust 

to missing or inaccurate data; 

 multi-collinearity does not affect the NN as in the regression model; 

 neural networks are reliable tools for predicting the basic elements of quality 

relationships. 

 Besides the advantages of using neural networks in management, disadvantages can also 

be recalled:  

 methods for determining the significance of independent variables (input) have not 

yet been developed; 
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 in neural modeling, based on the principle of black boxes, qualitative informations 

and precise methods for determining their configuration are missing; 

 weights of neural networks can not be interpreted in the same way as the regression 

coefficients, they indicate the importance of entries, but the analysis becomes difficult, 

sometimes impossible, due to the complex interactions of the interlayers; 

 it is difficult to determine the best solution; although there are techniques to avoid 

local minima, there is no guarantee defining the best networks; 

 model selection and its training is "art" not "science", based on trial and experience, 

however, a careful methodology may be followed, that would lead to the best model, even 

if it is not optimal; 

 like any other dynamically model, when submitted to changes in the external 

environment, the neural model needs to be rebuilt and retrained; 

 the learning process can sometimes be very long. 

 In general, compared with multivariate statistical methods, in many cases, neural modeling 

is a preferred alternative, both from the point of view of results, as well as a working methodology. 

Three arguments can be made for this comparison: 

 by applying neural networks in management issues, numerical or analytical inputs 

can be used; 

 complex interactions between input variables does not influence the performance of 

the neural model or the validity of the results, as it happens in the regression analysis; 

 it is possible the labeling of the intermediaries neurons and thus can be examined 

the conjunction of the factors that contribute to each hidden node to evaluate their impact 

on the modeling’s performances;  

 The managerial activity involves a continuous decision making process, consistent and 

sequentially. It was, thus, considered that the decision was in all of the management functions, and, 

hence, in the forecasting component, neural networks being of great help in this direction.  

 In the context of the performed analysis regarding the involvement of the  neural networks 

in the organizational management, it was found that human resources are the most important 

category of resources for an organization. The success or failure of an organization (including for 

those with specific production) depends crucially on the quality of the available workforce, its 

degree of motivation etc. 
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 In this context, neural networks can provide estimative datas of real value to the 

organization management for making decisions.  

 In this framework (of forecasting), neural networks can provide very useful information 

for the top management for making decisions as fair and balanced as possible, with a margin of 

success. 

Just as there are several classes of neurons that perform different functions, and still have  

the same basic structure, likewise there are many businesses, companies, firms, which, although 

they have different functions, they have the same basic structure. 

 Each department within the company, institution, firm ... has certain assignments, roles, 

tasks to fulfill, to meet both customer requirements and simultaneously creating products of the 

highest quality.  

 The assimilation of the organizational structure of a company with a neural network, will 

clearly allow the optimization of the managerial activity and getting a profit closer to the ideal 

value. 

 The paper highlights the possibility of assimilation of the departments provided in different 

organizational structures of companies, in eventual neurons of a neural network built on the specific 

of the company. 

 The assimilation of the organizational structure of the company with a neural network will 

implicity require the definition of the other specific network elements: input data, component 

layers, output data etc. 

 The strategic thinking translated into a neural network through the input elements, must 

take into account the specific elements of the moment of decision regarding the future strategy of 

the company. 

 In these circumstances, the use of Neural Networks- which is, nevertheless, a method of 

prognosis- is determined by all the information of the topmanagers in the field in which it is desired 

a scientific prognosis determined on the basis of basic elements, such as:  

- the establishment of technological advance; 

- advantages specific to the precursor; 

- disadvantages reported by the precursor.  

 Establishing with the aid of Neural Networks of the future strategy (offensive, defensive,  

absorbance, interstitial, incorrect) can be achieved by considering a number of entries like:  
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- the compensation potential concerning the financial result; 

- the potential in the technological innovation; 

- the ability to comercialise the products.  

  Through similarly with the possibility of using the "NN" in selecting the strategy of a  

company specialized in "NN", the application can expand -in accordance with the "product’s life 

cycle" (as shown) and on the nonconventional technology- considered as product- described 

through the four features: plant, specialized equipment, tools, operating modes.  

 Using "NN" - in taking managerial decisions in a comercial company – is being constituted 

in a provisional method, useful to the top management in order to ensure the maintenance and 

development of the company on the competitive market.  

 The paper briefly presents how to use the "NN" in the decision making process of 

establishing a future R&D strategy of a company specialized in NT, as well as the possibility  of 

applying the method even up to the technological processes.  

 In conclusion, it follows that the success and development of any industrial organization, 

that in the market economic system aims at designing, implementing and developing the "NT", 

means the adoption of appropriate R&D strategies in all of the manifestation directions of the 

enterprise’s functions.  

The main original contributions 

A. Theoretically 

 defining the concept of "NEURAL NETWORK" versus the concept of "NEURONAL 

NETWORK”;  

 defining the specific elements of a neural network applicable in the addressed field; 

 defining the industrial and R-D structures in which neural networks can be applied in order 

to establish a future strategy; 

 defining some organizational and staff structure analysis options for R-D organizations; 

 define and adapt some softwares and programs (MATLAB; Neurosolutions) for specific 

applications; 

 proposals have been made regarding the reproduction of the biological neuron in the 

structure of an organization; 

 the necessary elements for the use of neural networks in defining competitive strategies 

have been defined; 

 the strategies to be considered (offensive, defensive, absorbent, interstitial and incorrect) 

have been defined; 
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 how to assign numerical values specific to input indicators was presented. 

 

B. Practically 

- some general organizational models have been developed, for which, decision making 

by applying the neural networks can be adopted; 

- a package of information on the possible "entry" and "exit" data from a neural network 

applicable in the addressed field was elaborated; 

- some neural network structures adapted to specialized softwares have been developed 

(Neurosolutions and MATLAB); 

- specific case studies have been developed; 

- the neuro-fuzzy network modeling of the relationship between input indicators and 

strategies was analysed; 

- databases on the learning and training of the designed neural networks have been 

obtained. 
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